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Harris XL-185P | XL-200P Configuration Settings

Step 1. Obtain Radio Personality Manager 2 (RPM2) software from the
Harris Technical Assistance Center (TAC): 1-800-528-7711 (Opt.3) PSPC_TAC@harris.com
Step 2. Open the Harris RPM2 Software
Step 3. Connect the programming cable to the portable radio:
(A) Hook the pin side of the connector in the radio’s notch.
(B) Attach the connector with the Thumb screw.
Step 4. Insert the USB end of the cable in the computer that is running RPM2.
Step 5. Turn on the Radio using the volume knob.
Wait a few seconds for the screen to illuminate and start-up to complete.
Step 6. Navigating to the Radio’s Personality into RPM2:
(A) Navigate to the “Radio” tab, and “Personality” sub-tab.
(B) If not automatically selected, select the USB communication type.
(C) The Radio should show in the Connection list.
mﬁleﬂliochisHelp G A0 B W& X A S 0 s © w S - 0 X
aje) ¢ S | T
£ o\ e\l Personality . = !-- k= Connections: 1 Personalities: 1 °
EE
Connection MRU ESN Radio Name Radio Type Firmware ~ Manage Personality on the Radio £
) < A40302000721 MNA MSA_Radio_2 XL-Portable RO6A1S Radio Personalities
MSA G1 Rem ewf
Step 7. Set a unique Bluetooth pairing ‘friendly name’ for the connected radio: RPMZ ypdate friendly Name x
(A) Select the “Radio Name” Icon l T Radio Name
B K H . . A40302000721 MSA_Radio_2
(B) Key in desired name b
(C) Click the “Write Name to Radio” Button.
Step 8. Load the Radio’s “Personality” (its configuration) into RPM2 (for editing): Radic Pemsonalifies Re
(A) Check the box for the active personality on the connected radio. w— (| MSA G1 l
(B) Click the “Read Selected” Button s i
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Step 9.

Step 10.

Step 11.

Step 12.

The Personality will load into RPM2 in a new tab.

e Save this Personality to the local computer (to write to other radios
later) by opening the “File” menu, and choosing “Save as...”

File |Radic Tools Help

3 MNew »
] Open »
B Ssave

B SaveAs.

e Use the “Save” Icon (or the File menu and “Save” item) to save your
changes to the personality.

G O &R B X 4304 0 «

(A) Click on the Personality’s “Options” Section to expand it. —

(B) Choose the “Audio Settings” item.

Under “Audio Settings” > “Audio Menu Settings” and:
(A) Check “Speaker”
(B) “Noise Cancellation” OFF (unchecked)
In the “PTT Options” of the same “Audio Menu Settings” section:
(C) Check “PTT”
(D) Select “Accessory Only”

If the Harris radio is equipped with a Harris FSM Speaker, the Rx audio will
always be routed to BOTH the Harris FSM speaker AND the MSA G1 lapel
speaker. If desired, the firefighter can turn off the G1 Lapel Speaker (in
order to only play audio through the FSM speaker) by depressing the G1
Lapel Speaker’s button for 3 seconds.

If the Harris radio is NOT equipped with a Harris FSM speaker, the audio
will not play through the radio speaker if the G1 Lapel Speaker is turned
off; The G1 Lapel Speaker should be left ON in this situation.

Scroll down to “Bluetooth Microphone” options and:
Harris recommended settings are:

(A) Enable (check) “ALC”

(B) “ALC Max Gain” can be left at “6” (dB)

(C) Set “Mic Gain” to “8” (dB)

Consult your Harris radio technician before making adjustments to the
recommended settings.
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MSA G1 = Options > Audio Settings

Audio Settings

Audio Menu Settings

Speaker

Moise Cancellation

Moise Cancellation Type

Moise Suppression

Voice Assist Mode

PTT 7]

) Radio and Accessory ®

MSA G1 = Options » Audio Settings

Bluetooth Microphone
ALC
ALC Max Gain (dB)

Mic Gain (dB)
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Step 13.

Soft
Menu
Option

Step 14.

Step 15.

Step 16.

Back under the “Options” Section:
Scroll down to, and: MSA G1

e Select “Bluetooth Settings” XL-Portable

O Enable Bluetooth

Audio Settings

o Disble T Protctin
ooth 5 g Bluetooth Enabled [

Clock Settings

OPTION: Program a button or softkey to turn Bluetooth ON/OFF.

In this example we’ll program the front, center softkey (PF2).

Back under the Personality’s “Options”:

Portable Programmable Buttons
e Select:

e Scroll down to the button named “Key PF2”

e Set its “Operation” to “Bluetooth Enable/Disable”

Save the changes to the “Personality” as described in Step 9. Above.

Return to the “Radio Tab”.

In the “Program Personality to the Radio” box on the Bottom right:

Check the Personality to be written to the radio.

Click the “Write to Radio” button.

Rev. 5-23-2019
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MSA G1 » Options » Bluetooth Settings

d-

Bluetooth Settings

Bluetooth Allowed d

MITM Protection Required

User-Programmable
Button

User-Programmable

Soft Keys
User-Programmable 98

Buttons

Programmable Buttons Option
Mame Operation

Key PF2 Bluetooth Enable/Disable

& Q\ g MSA Gl  x

Program Personality to the Radio

) /| MSAG1 Specify Clear

-2 Write to Radio .- Read Selectec L ]
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G1 Bluetooth

Settings Tag Creating a G1 SCBA Configuration Tag (for Bluetooth Pair Save Preferences)

The purpose of this section is to: (1) enable the Bluetooth radio on the G1 SCBA and

Step 1.

Step 2.

Step 3.

Step 4.

Note:

Step 5.

Step 6.

Step 7.

Step 8.

(2) to set Bluetooth Pair Save behavior based on the department’s preference.
Launch the MSA A2 Software.

Select the “G1 Tags” Tile on the A2 Dashboard (Under the “G1 Devices”
column).

read & write G1 Tags

Select tag type: “G1 Configurations”

Select the Add (+) icon (top-right hand side of A2 application) to create the
configuration template, which will be used to change these 2 settings. @

Tag can be written without saving the template, but the template can be saved for

future use if given a name: "™ ErRswaraSs The Sgve [con (top-right) is enabled —) @ @
when the Name is filled in.
Enabllng the Gl SCBA'S BIuetOOth Rad|0 ;eﬂu:;ﬁgzr;ﬁ?;zll':ggielomh module in the device
(D) Expand the “Bluetooth Settings” section. ::ZE:Z: E:?Z‘:f”am hd
(E) Change “Bluetooth Disabled/Enabled” setting to “Enabled”. o Disabled
P TIC Setings
Preference Choice: “Bluetooth Pair Save” setting options: ~ Bluetooth Settings
. . . . These 56"[”’795 effect the bluetooth module in the device
(Generally, a department’s operating procedures will determine its preference) = gustooth DisabledEnabled [Erabed ]
(A) To apply a Radio Pairing Tag every time SCBA is turned on, choose “Disabled” = Bluetooth Pair Save v
(B) To retain the Radio Pairing on the SCBA until it’s cleared *, choose “Enabled” = » TIC Settings Disablod
*_ See “Clearing Radio Pairing Info from the G1 SCBA” page. i ven

Writing the G1 Configuration Tag:

(A) Place RFID Tag on the RFID Reader / Writer @ @ @ @)—

(B) Select the Write G1 Tag icon (top-right hand side of A2 application)

Applying the G1 Configuration Tag to the G1 SCBA(s):

(A) Power on the G1 SCBA

(B) Press & hold either of the green Control Module buttons to activate
the RFID mode.
For iTIC Control modules: Press & Hold Both Green Buttons.

(C) Place Bluetooth Pairing Save Tag over G1 Power Module RFID Target.

The G1 SCBA is now configured with the settings:
- G1 Bluetooth is now enabled - G1 Bluetooth Pair Save (as chosen).

The G1 SCBA is now ready to accept a Radio Pairing tag.

Repeat this “Step 8” for each SCBA to apply these 2 settings.

Rev. 5-23-2019 Page 5 of 13
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Creating a Harris XL-185P | XL-200P Radio Pairing Tag

Pair Tag

To pair the radio to the G1 SCBA, a “Bluetooth Audio Pairing Tag” needs created in the A2 Software.
Once the Pairing Tag is created, it can be applied to the SCBA, which “programs” the SCBA to connect

to that specific radio.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Launch the MSA A2 Software

Select the “G1 Tags” Tile on the A2 Dashboard (Under the “G1 Devices”
column)

Select tag type: “Bluetooth Audio Pairing Tags”

Ensure that your PC's Bluetooth adapter is on, and selected for use in A2,
and that your RFID Reader/Writer is connected and ready.

e Both modules appear in lower left of A2 display. Generally they will
appear as the computer's name, or as "localhost".

e |[f either is not visible there or under "Select Other device":
disconnect and reconnect the hardware;

e Restart the A2 service if necessary.

Turn on the Harris Radio using the volume knob.

Ensure Bluetooth is “ON” (BT Icon is visible).
The Radio should start with Bluetooth enabled, but if has been turned off:

(A) If Soft Button (front Display) is configured for Bluetooth on/off:

Press “Bluetooth”. The Bluetooth Icon should appear on the upper
display bar.

(B) Use the Settings menu: =

-
a. Pressthe button in the Center of the arrow pad togFals
radio’s settings menu sets.

b. Use the Left or Right arrow until the “Utility” menu (Gear Icon) is
highlighted on the little tabs at the top of the screen.

Up or Down arrow until “Bluetooth” menu is highlighted
Press the button in the Center of the arrow pad to open it.
Up or Down arrow until [Bluetooth] “Enabled” is highlighted

- 0 a o

Press the menu button in the Center of the arrow pad to change
“Enabled” to “YES”.

Rev. 5-23-2019
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Special G1 Tags
Copy Tag

Erase tag

Bluetooth Audio Pairing Tags

Connected Tag Writer:
Localhost

‘ Select Other Device |
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Step 7. Make the Radio Bluetooth Discoverable:

Note: Every time you power on the Harris XL-185P | XL-200P, it starts up
with Discoverability set to OFF. Follow this procedure to turn it ON.

If you left the Bluetooth Utility Menu, navigate back to it using the
procedure found on Page 6, Step 6. method (B) steps “a.” through “d.”, and
then:

(A) Up or Down arrow until “Discoverable” is highlighted

(B) Press the menu button in the Center of the arrow pad to change to
HYES”

(C) ** STAY ON THIS SCREEN ** Leaving the Bluetooth menu will turn
discoverability OFF again. To remain “discoverable” you must stay on
this screen.

Step 8. Discovering the Radio in A2:

(A) Click “Discover Devices”
You may have to scan twice if the Friendly name doesn’t appear.

(B) Select the tile for the discovered Radio in A2 to select it.
The discovered device info will load on the screen:

Discovered Bluetooth Device

Id c1c0438c-9bde-4da3-9afc-86ad6c671aad
Display Name MSA_Radio_1
Bluetooth Address D436395C4C39

Step 9. Writing the Bluetooth Audio Pairing Tag:
(A) Place RFID Tag on the RFID Reader / Writer

(B) Select the Write G1 Tag icon
(top-right hand side of A2 application)

(C) Click “OK” on the “Tag was successfully written” dialog.

Step 10. Verifying the Information Written to the Tag:
(A) Place RFID Tag on the RFID Reader / Writer

(B) Select the Read G1 Tag icon
(top-right hand side of A2 application)

(C) The “Found Tag” screen will appear.

(D) Confirm the tag’s Bluetooth Address matches the Radio.

The Radio Pairing tag is now created & can be used to pair this radio with a
G1 SCBA.

Rev. 5-23-2019
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\ ! '““7.. i
UME CONTROL
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** STAY ON THIS SCREEN **

—-—) Discover devices

Select a device you wish to update.
Ensure that your G1is in data link
muode before scanning.

D436395C4C39

& .0 X|

® @~

Note: Hovering over the icons will
also show “Write Tag” or “Read Tag”.

- ®®
Found Tag
uuID 1112
Display Name MSA_Radio_1
Bluetooth Address  D4:36:39:5C:4C:39
Pairing SSPJustWorks
Pin
Service AudioGateway
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Pairing G1 &

Radio Pairing a G1 SCBA and Harris XL-185P | XL-200P Radio

Ensure the Harris Radio is programmed correctly to connect with the G1 SCBA. Necessary and recommended settings are

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

listed in the “Harris Configuration Settings” page. Consult with your Radio Technician.

Turn on the Harris Radio using the volume knob.

Verify that Bluetooth is “ON” the radio Bluetooth icon is visible on radio
display. If not visible, enable the radio’s Bluetooth (See Page 6, Step 6, for
details) OR reconfigure radio.

SYSTEM UP " BLUETOOTH " SYSTEM DN,

Make the Radio Bluetooth Discoverable:

Note: Every time you power on the Harris XL-185P | XL-200P, it starts up
with Discoverability set to OFF. Follow this procedure to turn it ON.

If you left the Bluetooth Utility Menu, navigate back to it using the procedure
found on Page 6, Step 6. method (B) steps “a.” through “d.”, and then:

(D) Up or Down arrow until “Discoverable” is highlighted

(E) Press the menu button in the Center of the arrow pad to change to
llYESH

** STAY ON THIS SCREEN ** Leaving the Bluetooth menu will turn
discoverability OFF again, and pairing will fail.

To keep “Discoverable = YES” you must stay on this screen.

Press & hold either of the green Control Module buttons to activate the RFID
mode.

For iTic Control modules: Press & Hold Both Green Buttons.

Register the Radio to the SCBA: Place the Harris Radio Pairing Tag over the
G1 Power Module RFID Target.

After the pairing tag is successfully read, a Bluetooth enabled G1 SCBA will
search for a pairing partner for 8 minutes. The pairing process should be
repeated if 8 minutes is exceeded.

Rev. 5-23-2019 Page 8 of 13
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0 If you left the Bluetooth Settings screen (described in Step 3), Discovery is
turned OFF, and you will see a message popup like this.

Accepting the paring request sent from the SCBA will not be successful.

a) Repeatstep 3, 4, and 5.

k i/ 10:09 | A

GO T0 BLUETOOTH
SEITINGS TO PAIR

0K
SYSTEMUP T SCAN " SYSTEM DN

Step 6. When the Passkey Is presented on the radio:
Press the softkey for “ACCEPT”. PASSKEY

The Pairing Complete message will appear: 487428
Press the softkey for “OK”.

| ACCEPT 'Y W ENY

The G1 SCBA & Harris Radio is now paired and ready for use.

e After a successful pairing, if the regulator is shut off, the G1 SCBA will not remain

connected to the radio, and the radio is available for non-Bluetooth use.

e The G1 SCBA will automatically re-connect to the radio when the end user turns on

the G1 regulator & breathes.

If you encouter difficulty pairing the radio:

PASSKEY

PAIRING COMPLETE

e Clear the pair information stored on the radio, as described in the “Clearing SCBA Pairing Info from the Harris XL-

185P | XL-200P Radio” section in the pages hereafter.

e For good measure clear the pairing information on the SCBA, as described in the “Clearing Radio Pair Info from

the G1 SCBA” section in the pages hereafter.

e Repeat the “Pairing a G1 SCBA and Harris XL-185P | XL-200P Radio” procedure above.

Rev. 5-23-2019
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Using Paired

G1 & Radio Using the G1 SCBA and Harris XL-185P | XL-200P Radio

Confirm that the G1 SCBA, and Radio, are paired together: Radio Tag has been applied (or applied previously and pair is saved)

Step 1. Turn on the Harris Radio using volume knob.

Step 2. Don the G1 SCBA and G1 Facepiece.

Step 3. Turn on the G1 SCBA via pressurization.
e The G1 SCBA will try to establish a Bluetooth connection to the currently
paired radio for up to 8 minutes.

e  When found, it will quickly connect and disconnect, (and is now ready to
automatically activate when breathing.)

If the connection is not established, the pairing process described in the
previous section should be repeated.

Step 4. Begin breathing (with the regulator attached) and the radio and SCBA will
connect automatically (approx. 20 seconds).

S

All SCBA voice communication will now go from the SCBA through the portable radio.

Use Notes & Tips:
e Turn on the Harris radio prior to the G1 SCBA.

e If the regulator is shut off, the G1 SCBA will not remain connected to the radio, and the radio is available for
non-Bluetooth use. The G1 SCBA will automatically re-connect to the Harris radio when breathing on the G1
regulator.

e Verify both the incoming and outgoing audio functionality after the Bluetooth wireless connection is established.

Rev. 5-23-2019 Page 10 of 13
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Best practice is to: Clear the pairing information from both devices—the radio & the G1 SCBA. This prevents the G1 SCBA from
connecting to a previously-paired Bluetooth radio during the next start-up.

Clearing G1

SCBA Pair Clearing Radio Pair Info from the G1 SCBA

There are 3 methods for removing stored Radio pairing information from the G1 SCBA.
° All three methods are effective on G1 SCBAs configured with “Bluetooth Pair Save” being “Disabled”

° The “Battery Removal Method” is a popular method, however, note that this method is NOT effective when the G1 SCBA is
configured with the “Bluetooth Pair Save” setting set to “Enabled”.

G1 Pairing Removal Method 1 — Battery Removal (Only effective when the G1 “Bluetooth Pair Save” setting is “Disabled”)

Step 1. Remove G1 SCBA Battery

Bluetooth audio pair info is cleared from the G1 SCBA.
Next = “Clearing SCBA Pairing Info from the HARRIS XL-185P| XL-200P Radio” section, hereafter.

G1 Pairing Removal Method 2 — Pair New Radio

Step 1. Pair a different Bluetooth Harris Radio with the G1 SCBA using the new radio’s Bluetooth Audio Pairing Tag, as
described in the “Pairing a G1 SCBA and Harris XL-185P | XL-200P Radio” section.

Bluetooth audio pair info on the G1 SCBA is changed to the pair info for the new radio.

Next = “Clearing SCBA Pairing Info from the HARRIS XL-185P | XL-200P Radio” section, hereafter.

G1 Pairing Removal Method 3 — Use a “Reset Bluetooth Pairing” Tag

If not yet created, create a “Reset Bluetooth Pairing” Tag in the A2 software, under “G1 Tags” tile = “Special G1 Tags”
2 expand “Reset Tags” list = Select “Reset Bluetooth Pairing”

Step 1. Press & hold either of the green Control Module buttons to access the RFID mode display.
Step 2. Place the “Reset Bluetooth Pairing” Tag over the G1 Power Module RFID Target.

Bluetooth audio pair info is cleared from the G1 SCBA.
Next = “Clearing SCBA Pairing Info from the HARRIS XL-185P | XL-200P Radio” section, hereafter.
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Clearing Radio

Pair Clearing SCBA Pairing Info from the Harris XL-185P | XL-200P Radio

Step 1. Press the button in the Center of the arrow pad to enter the radio’s settings menu sets. . =

Step 2.  Use the Left or Right arrow until the “Utility” menu (Gear Icon) is highlighted

on the little tabs at the top of the screen. UTILITY e

r
Step 3. Press Down arrow until “Bluetooth” menu is highlighted, and press the button
in the Center of the arrow pad to enter it.

Step 4. Press Down arrow until “Pairing Mgmt.” is highlighted, and press the button in
the Center of the arrow pad to enter it.

Step 5. Select a device to be unpaired and press the soft key for the “OPTIONS” action.
Select “Delete All” to clear all SCBA pairs.

Select “Yes” to delete All pairs.

DELETE ALL PAIRINGS?

Bluetooth audio pair info is cleared from the Harris Radio.

If not done already: Clear the pairing info from the previously connected G1 SCBA’s pair history using the process
described in the “Clearing Radio Pair Info from the G1 SCBA” section, above.
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Troubleshooting

Topic

Problem/Issue

Diagnosis

Possible Solution

Expected Result

Intermittent Audio

Facepiece may not be
properly sealed

Adjust the facepiece until a
proper seal is formed

Outgoing audio will function
as expected

Incoming and/or outgoing
audio from G1 is not working

Bluetooth icon is visible
on the Radio

Power the portable radio on
and off to reset the auto
connect.

Radio will automatically
connect to G1 and emit an
audible indication for success.

If power cycling the radio does
not result in a successful connect,
clear the G1 & Radio pairing
history and re-pair the G1 &
Radio.

G1 & Radio will now connect
and audio will function as
expected

Poor audio quality from G1
to Radio

G1 has Firmware SW
2.003 or prior SW
version

Update G1 to Firmware SW 3.0
via A2 Software

Improved G1 outgoing
audio quality

Bluetooth pairing
information lost from G1

Pairing information is
cleared when the
battery G1 battery is
removed. (When G1
“Bluetooth Pair Save”
is not set to enabled.)

G1 with SW 3.0 or higher is
configurable to retain pairing
information across battery
removals. Review instructions
for “G1 SCBA Configuration
Tag” and Bluetooth

Paring Save settings.

Bluetooth pairing
information will no longer
be cleared on every battery
removal.

Radio will not pair with G1

Bluetooth icon is NOT
visible on the radio

Turn Bluetooth on, on the
Radio.

If turning on Bluetooth on the
radio does not work: clear the
G1 & Radio pairing history.
Re-pair the G1 & Radio.

Bluetooth icon is visible on
Radio and pairing is now
successful.

Bluetooth Discoverable
is set to “NO”

Go to Radio Bluetooth Settings
and Set Discoverable to “YES”
and STAY ON THIS SCREEN
DURING PAIRING. Re-apply
the Pairing Tag to the G1.

Paring will successfully
complete.

G1is not Bluetooth
enabled, icon on control
module is gray.

Enable Bluetooth on the G1
using a G1 Configuration tag
that enables Bluetooth.

Bluetooth icon on the G1
control module will be:

Red = enabled/unpaired OR
enabled/paired, not
connected

Green = enabled/connected

Radioisanota
Harris XL-185P | XL-
200P Bluetooth Radio

G1is compatible with
Harris XL-185P | XL-200P
Bluetooth Radios.

To use G1 Bluetooth
audio, pair with a Harris
XL-185P | XL-200P

Radio is paired to an
incorrect G1

Radio and/or G1 was
previously paired to a
different radio or G1

Clear the pairing information on
both the G1 & Radio. Pair
desired G1 & Radio

Desired G1 and Radio will
be paired together
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